[image: image5.png]Mi

0S|




Office 2000 Guided Tour

[image: image6.png]


For IT Professionals
Published: January 1999

Table of Contents3Introduction to the Guided Tour

Hardware and Software Requirements
3
Installation Instructions
4
Introduction to Microsoft Office 2000
4
Simplified User Experience
5
Personalized Menus and Toolbars
5
Collect and paste
6
Word Click–n-Type
7
Quick File Switching
7
Microsoft Office E-mail
7
Office Assistant Out of the Box
8
Help on the Web
8
Excel AutoFill w/formatting
9
AutoFit in PPT
9



[image: image7.png]


Office 2000 Guided Tour

Simplified User Experience 

Published: January 1999

For the latest information, please see http://www.microsoft.com/office/  

Introduction to the Guided Tour

The purpose of a guided tour is to both inform and give a hands-on experience to the reader. This guided tour is designed for the IT Professional who will be responsible for evaluating, implementing, deploying, maintaining, and supporting Microsoft( Office 2000. This guided tour may also be of interest to end users or training professionals. This guided tour, Simplified User Experience, is one of three Office 2000 Guided Tours. The other two are Reducing the Cost of Ownership, and Increased Integration with the Enterprise.

The next section of this document will cover the hardware and software requirements, installation instructions, and pre-tour setup instructions.

Then, the tour begins! Each section of the tour will start with a brief explanation of the user need, the Office 2000 solution, and the technology in use. Next, you get to try it! We include step-by-step instructions to follow the tour, and screen shots so you’ll know if your tour is proceeding as we planned it. The first time you take this tour, you may want to stick to the established itinerary to ensure that you will be able to run through the entire tour. Following that, feel free to explore the applications and sample files as much as you’d like. Since this is beta software, it is probable that some features may not work exactly as described in some of the other evaluation documents provided, such as the Product Enhancements Guides.

Hardware and Software Requirements

Hardware Requirements

One Client Computer with the following Beta 2 minimum requirements:

· A Pentium with 32 MB or better

· Approximately 200 MB hard disk space for typical installation

· CD-ROM drive

· VGA or higher-resolution video adapter (Super VGA, 256-color recommended)

· Microsoft Mouse, Microsoft IntelliMouse®, or compatible pointing device

· 9600 or higher-baud modem (28,8000 baud or higher recommended)

Software Requirements

Client Computer Software Requirements

· Windows( 95, Windows 98, or Microsoft Windows NT( Workstation 4.0 with Service Pack 3.0 installed.

Installation Instructions

Base Installation Instructions

1) For all software listed in the above requirements sections, use the standard installation instructions to install the software.

2) Install the demo files in \\GuidTour to a folder on your hard drive called \\GuidTour. All files that you are prompted to open in this guided tour are located in this folder.

Introduction to Microsoft Office 2000

Office 2000 advances the business productivity software category by providing new tools that allow IT professionals to better manage their Office environment. With its new Web-based capabilities, Office 2000 streamlines how people work together and share information.

In direct response to customer feedback gained through site visits, in-depth interviews and work with the Office Advisory Council
, Office 2000 focuses on the following objectives:

· Significantly Reduce the Cost of Ownership. Reducing the total cost of ownership is the highest priority goal for Microsoft Office 2000.  Based on feedback from customers, we determined that the best way to reduce the cost of owning Microsoft Office is to make it easier to install within a large organization and make it easier to maintain and support once it’s been installed. Using the new Windows Installer technology, the Office group has redesigned Microsoft Office installation from the ground up, providing unparalleled flexibility and capabilities that have never been offered in desktop applications software. 

· Increase Office Integration with the Web and the Enterprise. Office 2000 extends communication to include Web publishing, real-time or ad-hoc document collaboration, and analysis using the Web. It also tightly integrates with the Microsoft BackOffice® family to facilitate better information sharing through the Office applications. 

· Simplify the User Experience. Over 25 percent of the features requested through the Microsoft Office Wish Line were for features already in the product. This told us that product functionality needs to be more discoverable and easier to use. Office 2000 addresses this need with better natural language support and an adaptable user interface. This simplified user experience decreases support costs while increasing user productivity and enjoyment.

The rest of this tour will step you through the enhancements in the simplified user experience area.

Simplified User Experience

Personalized Menus and Toolbars

Personalized Menus are a unique solution to a long-term problem — how to focus on just the things a user needs and uses. When users first start Office, the application menus will contain those commands that are used 95 percent of the time, while infrequently used commands do not immediately clutter the menu. At the bottom of each menu is a button that expands the menus to the full selection of choices so users can still easily find all menu commands. In addition, the menu will automatically expand based on IntelliSense rules (e.g., timing, hovering, etc.) As users access menu commands, they are “promoted” and displayed higher on the list. Unused menu commands are visually suppressed and not displayed on Personalized Menus. After a period of usage, menus will display the commands used most often and hide the ones never or rarely used. When users want to explore new features, they can quickly expand the menus to find them. In the meantime, users are only shown what they use, greatly simplifying the interface. IT administrators have the flexibility to customize or disable this feature. 

Personalized Toolbars work very similarly to Personalized Menus. Office 2000 Personalized Toolbars are displayed on a single row overlapped. Users can click a “slider” button to see and access a full toolbar. As users click on buttons and use them, they are promoted and displayed. Unused buttons are visually suppressed under the overlap. Over time, the toolbars thus configure themselves to users’ needs. This provides for less screen clutter and increased accessibility to the functions that users access most commonly.

You Try It!

1) Start Word if it’s not running and open PromPlan.Doc. 

2) Re-set your menus in the application by choosing Tools, Customize. Click on the Options tab and click on the Reset My Usage Data button. Click the Yes button in the warning dialog box. Click Close to close the dialog box.

3) Click the Format menu to make it drop down.

4) Hover over the menu for 2 – 3 seconds. You should see longer menus appear. The items that look like they are buttons in the down position are those that are normally suppressed visually.

5) Choose Change Case and click OK.

6) Wait a couple seconds.

7) Click on the Format menu to make it drop down. The menus should be short again, but Change Case should now appear.

8) Click on the chevron [image: image1.bmp] at the end of the Formatting Toolbar.

9) Choose Add or Remove Buttons
10) Click on Language.

11) Click off the menu to turn it off.

12) Click on the chevron [image: image2.bmp] at the end of the Standard Toolbar.

13) Click on the Document Map [image: image3.png]


button.

14) Notice that it has been moved to a visible position on the toolbar.

Collect and paste

Gathering information from several sources has always been a common task. Now with the wealth of data on the Internet, users are demanding better integration with multiple sources of information and the ability to manage several pieces of information at once. Collect and Paste provides the means to manage multiple pieces of information in Office 2000 more easily, going beyond the single step Copy and Paste used with previous versions. Using the standard Clipboard in Windows, users typically copy information, switch windows, paste, switch windows, copy, switch windows, paste and so on. The Microsoft Office Clipboard allows users to easily copy multiple groups of text or pictures from one or more documents, e-mail messages, Web pages, presentations or other files. Users can then paste these groups into any Office application, either individually, or all at once using the handy Paste All feature.

You Try It!

1) Start Word
2) Open the \\GuidTour\PromPlan.Doc document.

3) Select the Adventure Works logo and copy it, using the Edit, Copy command on the menu bar.

4) Start Excel.

5) Open the \\GuidTour\BreakEvn.xls spreadsheet.

6) Copy the financial data by selecting all of it, and using the Edit, Copy command on the menu bar.

7) Start Internet Explorer.

8) Go to your organization's home page or any other web page you can access.

9) Select some text, right click on it and choose Copy.

10) Switch back to Word.

11) Start a new document by clicking on the New button.

12) View the Office clipboard by choosing View, Toolbars, Clipboard.
This is what it should look like: [image: image4.png]B2 @Paste All 8 | Close
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Note: you may have more items if you've been doing any other copying.

13) Click on each of the miniature images of the different content to paste them into this document, or click on the Paste All button.

14) Close the file without saving changes.

Word Click–n-Type 

Click-n-Type allows users to insert text in a document by simply double-clicking where they want to type. Word shows users what formatting will be applied through simple cursor hinting and automatically applies the appropriate formatting such as extra lines, tabs, alignment and text wrapping. This makes it easy to center-align titles, to create indented paragraphs, or to create a single line with text in different places (e.g., left aligned on the left, right aligned on the right).

Quick File Switching 

Quick file switching (like Single Document Interface) provides immediate access to any individual Office document, rather than the application itself. If a user has more than one document open in any Office 2000 application, each document will have its own button on the Windows Taskbar. This is a response to customers wanting an easy way to switch between open documents, especially during cut-and-paste or drag-and-drop operations. 

You Try It!

1) If Word is not running, start Word.

2) Open \\GuidTour\PromPlan.doc.

3) Create a new document using the New button on the Standard Toolbar.

4) Create another new document using the New button on the Standard Toolbar.

5) Look at the Windows Taskbar. You should see three buttons for Microsoft Word, each one with a different document name.

6) Click on the PromPlan document button.

7) Click on the Adventure Works logo and drag it to the Windows Taskbar.

8) Hover over the Document2 button until that window becomes the active one.

9) Drag the logo to any location on the document and release the mouse button.

10) Double click the cursor to the right of the logo, about centered vertically. This moves your cursor to where you want to place text without having to understand formatting, paragraphs, tabs, etc.

11) Type the text “Our new logo!”

12) Close all files without saving changes by holding down the shift key while choosing File, Close All. Say No to saving changes.

13) Look at the Windows Taskbar. There is only one button for Word now.

Microsoft Office E-mail

In Office 2000, e-mail functions are built right into all the applications through the Mail Header toolbar. This means that instead of having to launch an e-mail application and then attach a file, users can choose to send documents right from within the application. For example, instead of creating a sales report in Excel, saving it, starting Outlook and sending the report as an attachment, a user can create the report, send it right from Excel and continue working on the report.

Furthermore, because Office 2000 uses HTML as a companion file format, users can send files in HTML format. This means users don’t have to worry whether the recipients have the right application to read the material—any recipient with an HTML-compliant e-mail reader can view the mail with full fidelity. HTML-compliant e-mail readers include Microsoft Outlook and Outlook Express, Eudora, several Lotus clients and several Netscape clients.

You Try It!

1. Start Excel if it isn’t running.

2. Open the \\GuidTour\BreakEvn.xls spreadsheet.

3. Choose File, Send To, Mail Recipient.

4. Click on the To… button in the address header. Choose an e-mail recipient and click OK.

5. Click “Send the Sheet”.

6. E-mail has now been sent where the spreadsheet is the message, not an attachment.

Office Assistant Out of the Box

Office 2000 improves the Office Assistant for users who love it as well as for those who choose not to use it. However, those who turned it off before may now appreciate the improvements and decide to keep it around. The Office 2000 Assistant works out of the box. This means it has no window around it, so it takes up less screen real estate, blends in more naturally with users’ work, and is more visually appealing.

Help on the Web

While the Assistant’s ability to understand users’ questions has also improved, Microsoft recognizes that every question cannot be anticipated. In an effort to offer users additional help and to assist in improving the Assistant, Microsoft provides Help on the Web. If the Assistant can’t answer a question, it will take the user to a special Web site with additional information. This site also gives users the option of telling Microsoft what they were trying to ask and what kind of response was expected, so that Microsoft can improve the Assistant in the future. In spite of all these improvements, some users will still want to turn off the Assistant. Office 2000 makes this work better, so that when a user says “off,” it really is off.

You Try It!

1) Check the new Office Assistant look and options.

a) Start up Excel. The office Assistant should appear on screen. If it doesn't choose Help, Microsoft Excel Help. Notice the different look of the Assistant.

b) Right click on the Assistant. Choose Hide.

c) Turn the Assistant on again. Right click on the Assistant, and choose Options. View the options to see what choices you can make. All of these settings can be changed and rolled out with your Office installation.

Microsoft Excel AutoFill w/formatting

Excel 2000 automatically extends formatting and formulas in lists, simplifying this common task and helping users work more efficiently.

You Try It!

14) Start Excel if it isn’t running.

15) In six cells, create the following text:

Today
Tomorrow
Yesterday

Tomorrow
Yesterday
Today

16) Select the three cells in the top row and make their background green by choosing Format, Cells, Patterns and clicking on a green color square. Click OK to close the dialog box.

17) Select the three cells in the next row and make their background red by choosing Format, Cells, Patterns and clicking on a red color square. Click OK to close the dialog box.

18) Select all six cells. Drag from the bottom right hand corner down four more rows to AutoFill the next four rows. Notice that the formatting is filled as well.

19) Select the cell in the very next row, in the first column.

20) Type “Yesterday” and press Enter.

21) The formatting should have been continued for this cell as well.

22) Close Excel without saving changes.

AutoFit in PPT

In PowerPoint 2000, text is automatically resized to fit into a placeholder so that it doesn’t “fall off” the slide. AutoFit changes the line spacing, then the font size — and then both — to make the text fit. This means that users don’t have to spend time trying to make the text fit — it happens automatically.

You Try It!

23) Start PowerPoint if it isn’t running.

24) Click on Open to open an existing presentation.

25) Choose \\GuidTour\PromPres.ppt.

26) In the left-hand pane, click on slide 4, “Where we are today”.

27) Click on the slide right below the last bullet point.

28) Type “Employee satisfaction is good.”, look at the screen, and press Enter.

29) As soon as you do, The text onscreen resizes so it will all fit on screen. The Office Assistant Tip light bulb should light up. When you click on it, the Assistant will tell you that it has automatically resized your text to fit on the slide. 

30) Close PowerPoint without saving changes.

For more information: http://www.microsoft.com/office/ 
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